QualNet 4.5.1
Installation Guide

July 2008

Scalable Network Technologies, Inc.
6100 Center Drive, Suite 1250
Los Angeles, CA 90045
Phone: 310-338-3318
Fax: 310-338-7213
http://www.scalable-networks.com
http://www.qualnet.com
Copyright Information

© 2008 Scalable Network Technologies, Inc. All rights reserved.

QualNet is a registered trademark of Scalable Network Technologies, Inc.

All other trademarks and trade names used are property of their respective companies.

Scalable Network Technologies, Inc.
6100 Center Drive, Suite 1250
Los Angeles, CA 90045

Phone: 310-338-3318
Fax: 310-338-7213

http://www.scalable-networks.com
http://www.qualnet.com
Preface

1 Installation Guide for Windows

1.1 System Requirements

1.2 Installing QualNet

1.3 Installing Third-Party Software

1.3.1 Java Support

1.3.2 C++ Compiler

1.4 Setting Environment Variables

1.5 Compiling and Testing

1.5.1 Compiling from Command Line

1.5.1.1 Compiling 32-bit QualNet

1.5.1.2 Compiling 64-bit QualNet

1.5.2 Compiling from Visual Studio 2005 IDE

1.5.3 Testing QualNet

1.6 Installing and Activating Addons

1.6.1 Installing Addons

1.6.2 Activating Addons

1.7 Helpful Links

2 Installation Guide for Linux/Solaris/Mac OS X

2.1 System Requirements

2.1.1 Linux

2.1.2 Solaris
Preface

*QualNet 4.5.1 Installation Guide* describes the system requirements, installation process, compilation, and running QualNet on Windows, Linux, Solaris, and Mac OS X systems.
QualNet Document List

The following list shows the QualNet Documentation set and gives a brief description of each document.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QualNet 4.5 API Reference Guide*</td>
<td>This reference guide provides detailed information on the QualNet API functions and parameters.</td>
</tr>
<tr>
<td>QualNet 4.5 Distributed Reference Guide*</td>
<td>This guide gives instructions for running QualNet on a distributed architecture.</td>
</tr>
<tr>
<td>QualNet 4.5.1 Installation Guide</td>
<td>This guide provides detailed steps for installing QualNet 4.5.1 on UNIX/Linux/Mac and Windows platforms.</td>
</tr>
<tr>
<td>QualNet 4.5 Product Tour*</td>
<td>This document is designed to quickly cover the basic features of QualNet 4.5.1 for experienced network modelers. It includes exercises and example scenarios.</td>
</tr>
<tr>
<td>QualNet 4.5.1 Programmer’s Guide</td>
<td>This is a guide to the QualNet programming interface and functions, allowing users to develop and customize protocol models. The Programmer’s Guide has been updated for QualNet 4.5.1.</td>
</tr>
<tr>
<td>QualNet 4.5.1 User’s Guide*</td>
<td>This guide is a detailed look at the QualNet 4.5.1 environment and works in combination with the new QualNet Model Libraries set of documents to provide extensive information on QualNet protocols for the 4.5.1 release. The User’s Guide has been updated for QualNet 4.5.1.</td>
</tr>
</tbody>
</table>
| QualNet 4.5.1 Model Libraries                               | This set of documents contains detailed reference information on all of the models used in QualNet 4.5.1. The set of documents includes the following model libraries. See QualNet 4.5.1 Model Library Index for an alphabetical list of all our models and a reference to which library they can be found in.  
  - Advanced Wireless*  
  - ALE/ASAPS Advanced Propagation*  
  - Cellular*  
  - Developer*  
  - Military Radios*  
  - Multimedia and Enterprise*  
  - Network Emulation Interface*  
  - Network Security *(updated for QualNet 4.5.1)*  
  - Satellite*  
  - Sensor Networks*  
  - Standard Interfaces*  
  - TIREM Advanced Propagation*  
  - UMTS *(new for QualNet 4.5.1)*  
  - Urban Propagation Advanced Propagation*  
  - Wireless *(updated for QualNet 4.5.1)* |

**Note:** The documents marked with '*' have not changed from the 4.5 release to the 4.5.1 release.
Document Conventions

QualNet documents use the following conventions:

<table>
<thead>
<tr>
<th>Book Title</th>
<th>The title of a book. On the web and on the Instant Information CD, it may be a hot link to the book itself.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Input</td>
<td>A command name or qualified command phrase, daemon, file, or option name.</td>
</tr>
<tr>
<td>Command Output</td>
<td>Text displayed by the computer.</td>
</tr>
<tr>
<td>Note:</td>
<td>Information of special interest.</td>
</tr>
<tr>
<td>[]{}</td>
<td>In syntax definitions, square brackets indicate items that are optional and braces indicate items that are required.</td>
</tr>
<tr>
<td>Code Segment</td>
<td>Segment of code from QualNet source files used for illustration.</td>
</tr>
<tr>
<td>Added Code</td>
<td>Example of code that the user should add to existing QualNet functions and declarations to add a custom model to QualNet. A vertical margin in the left column indicates new lines of code that need to be added.</td>
</tr>
<tr>
<td>Ellipses (...)</td>
<td>Ellipses are used to indicate lines of code from QualNet source files that have been omitted from an example for the sake of brevity.</td>
</tr>
</tbody>
</table>

More Information

This section describes how to contact us for more information on QualNet products and documentation. It provides links to helpful QualNet sites and information on getting in touch with QualNet.

- For more information on QualNet products, please contact QualNet Sales at sales@scalable-networks.com or visit the Scalable Network Technologies website (www.scalable-networks.com) and click on Products.
- For help on QualNet products, please contact QualNet Support at support@scalable-networks.com or visit the Scalable Network Technologies website (www.scalable-networks.com) and click on Training and Support.
- For help on QualNet documentation, please contact QualNet Support at support@scalable-networks.com or visit the Scalable Network Technologies website (www.scalable-networks.com) and click on Documentation.
1 Installation Guide for Windows

This section covers the system requirements, installation process, compilation, running, and debugging QualNet on Windows.

1.1 System Requirements

QualNet is supported on Microsoft Windows XP (Home and Professional), and Microsoft Windows XP Professional x64 Edition. The minimum platform requirements to run QualNet on a Windows system are listed in Table 1.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>x86 compatible (including Intel Core Duo, Pentium, Xeon, and AMD Athlon).</td>
</tr>
<tr>
<td></td>
<td>Or</td>
</tr>
<tr>
<td></td>
<td>AMD64 compatible (including AMD Opteron, Athlon 64, Intel Core 2 Duo, and Pentium/Xeon EM64T).</td>
</tr>
<tr>
<td>Memory</td>
<td>- 512 MB for simulations of networks with up to 100 nodes.</td>
</tr>
<tr>
<td></td>
<td>- 768 MB for simulations of networks with up to 250 nodes.</td>
</tr>
<tr>
<td></td>
<td>- 1 GB for simulations of networks with up to 1000 nodes.</td>
</tr>
<tr>
<td>Disk</td>
<td>500 MB free disk space.</td>
</tr>
<tr>
<td>Java</td>
<td>Sun Java™ 2 SDK, Standard Edition, version 1.4.2 or higher.</td>
</tr>
<tr>
<td>C++ Compiler</td>
<td>VC7 or higher (see Section 1.3.2)</td>
</tr>
</tbody>
</table>

The following is the recommended configuration to run QualNet Developer on Windows:

- One of the following processors:
  - 3.2 GHz Pentium 4
  - 2.4 GHz 32-bit AMD
  - Any AMD 64-bit
  - Any Intel Core Duo (or newer)
- 1 GB memory
- 700 MB free disk space
- Sun Java™ 2 SDK, Standard Edition, version 1.4.2
- VC7 or higher (see Section 1.3.2 for a list of supported C++ compilers)

In the addition to the above, the following are recommended when running QualNet 3D Visualizer on Windows:

- Graphics card with 128 MB memory
- Display with 1024 x 768 resolution
1.2 Installing QualNet

To install QualNet on Windows, perform the steps listed below.

Notes:

a. The examples in this installation guide use the filename for the QualNet 4.5.1 Commercial Release. Users may need to modify the filename to match the name of the file delivered.

b. For help with installation procedures or problems, contact support@scalable-networks.com.

1. Download the installation package (file qualnet-4.5-commercial-installer.exe) from the QualNet download page or load it from the installation CD.

2. Double click on the file qualnet-4.5-commercial-installer.exe.

3. After reading the license agreement, agree to it by selecting the “I accept...” option in the License Agreement dialog box and click Next.
4. The ReadMe information dialog box is displayed. Click Next.

5. Select the components to install in the Choose Components dialog box. The default type of install is Full. Click Next. (It is recommended that you select Desktop Shortcuts. Although this is not required, it will make compilation from command line easier.)
6. The **Destination Folder** dialog box is displayed. Select an installation folder and click **Install** to begin the installation.

   **Note:** The default folder is C:\qualnet\4.5.
   In the rest of this guide, QUALNET_HOME refers to the folder where QualNet is installed.

![Installation Screen](Image)

   **Note:** If any of the setup information needs to change, click **Back** to make those changes.
7. The following screen will be displayed while QualNet installs:

![QualNet Installation Screen]

8. When prompted, copy the license file to the license directory.

![License Copy Prompt]

If a floating license server is not used, the license file name is of the form qualnet-<date>.lic, where <date> is the license expiration date. For example, the license file may be named qualnet-2008.06.30.lic. If a floating license server is used, the license file name is of the form client-<ip-address>.lic, where <ip-address> is the IP address of the client.

Copy the license file into QUALNET_HOME\license_dir, where QUALNET_HOME is the directory where QualNet is installed.

**Notes:**

a. Be sure to check the file extension on your license file. It should end in ".lic". Depending on your system and method of copying, you may end up with an extra extension, such as qualnet-2007.12.31.lic.txt, which will not work.

b. If this file cannot be located, inquire with the purchaser of QualNet. For users with the evaluation version of QualNet, the license file is sent as an email attachment from Scalable Network Technologies.
c. If a license server is used, follow the instructions provided with the license files to install the server and client license files.

9. Once the installation process has finished, the following screen will be displayed:

Click **Next**.
10. The following screen will be displayed:

Select from the options and click **Close**.

The Installer will place the following icons on the desktop if the *Desktop Shortcuts* option was selected in Step 5:
Installation Guide for Windows

1.3 Installing Third-Party Software

Java support is required to run the QualNet GUI. A C++ compiler is required to recompile the source code when models are added or modified. This section describes how to install the required software on a Windows system.

1.3.1 Java Support

Sun Java 2 SDK, Standard Edition, version 1.4.2 or higher, is required to run the QualNet graphical tools. Go to the following URL for information on downloading Java:


1.3.2 C++ Compiler

To compile QualNet source code or custom addons, one of the C++ compilers listed in Table 2 is required. For convenience, this installation guide will refer to the compilers by their abbreviations.

<table>
<thead>
<tr>
<th>C++ Compiler</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Visual C++ .NET 2002</td>
<td>VC7</td>
</tr>
<tr>
<td>Microsoft Visual C++ .NET 2003</td>
<td>VC7</td>
</tr>
<tr>
<td>Microsoft Visual Studio 2003</td>
<td>VC7</td>
</tr>
<tr>
<td>Microsoft Visual Studio 2005</td>
<td>VC8</td>
</tr>
<tr>
<td>Microsoft Visual C++ 2005 Express Edition</td>
<td>VC8 Express</td>
</tr>
</tbody>
</table>

Notes:


The INCLUDE and LIB environment variables must be set to their respective paths within the Windows Platform SDK installation (see Section 1.4).

b. Instructions for using Visual Studio 2005 and Visual C++ 2005 Express Edition are very similar. Where there are significant differences, instructions for using these two compilers are given separately; otherwise, instructions for Visual Studio 2005 also apply to Visual C++ Express Edition.

1.4 Setting Environment Variables

If you are using Microsoft Visual C++ 2005 Express Edition, then update the INCLUDE and LIB environment variables as follows (this assumes that Windows Platform SDK was installed at the default location):

1. Right click on My Computer and select Properties from the menu. Select the Advanced tab and click on Environment Variables.
2. Update the `INCLUDE` environment variable to include the following:
   
   ```
   C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Include
   ```

3. Update the `LIB` environment variable to include the following:
   
   ```
   C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Lib
   ```

   **Note:** The following environment variables are automatically set by the QualNet installer:
   
   - The environment variable `QUALNET_HOME` is set to the root directory of the QualNet distribution
   - The directories `QUALNET_HOME\bin` and `QUALNET_HOME\lib` are added to the system path.

### 1.5 Compiling and Testing

It is not necessary to compile QualNet on Windows if the initial installation is used with the default options. However, QualNet will need to be recompiled if modifications are made or custom protocols or addons are included. To compile QualNet from the command line, follow the instructions given in Section 1.5.1. If Microsoft Visual C++ 2005 Express Edition or Visual Studio 2005 is installed, QualNet can also be compiled from the IDE by following the instructions given in Section 1.5.2. After compiling QualNet, test the build, as described in Section 1.5.3.

#### 1.5.1 Compiling from Command Line

QualNet can be compiled from the command line using any of the supported C++ compilers (see Section 1.3.2). To compile the 32-bit QualNet, follow the instructions given in Section 1.5.1.1. To compile the 64-bit QualNet, follow the instructions given in Section 1.5.1.2.

##### 1.5.1.1 Compiling 32-bit QualNet

The 32-bit QualNet can be compiled on any of the following platforms:

- Microsoft Windows XP (Home or Professional) with one of the following compilers (see Table 2):
  - VC7
  - VC8
  - VC8 Express
- Microsoft Windows XP Professional x64 Edition with one of the following compilers:
  - VC8
  - VC8 Express
To compile the 32-bit QualNet from the command line, perform the following steps:

1. If QualNet desktop shortcuts are installed, open the QualNet Developer command window by double-clicking on the following icon on the desktop.

   ![QualNet Developer Command-Line Icon]

   Verify that the environment variables are properly set by typing the following command:

   ```
   cl
   ```

   The following output verifies that the configuration is correct:

   ```
   Microsoft (R) 32-bit C/C++ Optimizing Compiler Version 14.00.50727.42
   for 80x86
   Copyright (C) Microsoft Corporation. All rights reserved.
   
   usage: cl [ option... ] filename... [ /link linkoption... ]
   ```

   (The compiler version in the above output may differ depending on which version of C++ is installed.)

   If the configuration is correct, then skip step 2 and go to step 3.

   If a “file not found” error is displayed, then go to step 2.

2. If QualNet desktop shortcuts are not installed or a “file not found” error was displayed in step 1, open a command window using one of the steps listed below.

   • For VC7, use the following command:

     ```
     Start > All Programs > Visual Studio .NET > Visual Studio Tools > Visual Studio .NET Command Prompt
     ```

   • For VC8, use the following command:

     ```
     ```

   • For VC8 Express, use the following command:

     ```
     ```

3. Go to QUALNET_HOME\main directory using the `cd` command to change directories.

4. Make a copy of the appropriate Makefile.

   • For VC7, use the following command:

     ```
     copy Makefile-windows-vc7 Makefile
     ```
Compiling and Testing

• For VC8 or VC8 Express, use the following command:

    copy Makefile-windows-vc8 Makefile

5. Compile QualNet by using the following command (it takes several minutes for QualNet to compile):

    nmake

This creates the QualNet executable in the QUALNET_HOME/bin directory. In Windows, the executable is qualnet.exe.

To recompile QualNet, run nmake again. However, it is sometimes useful to delete all object files before recompiling. Use the following commands to remove all object (.obj) files and recompile:

    nmake clean
    nmake

1.5.1.2 Compiling 64-bit QualNet
The 64-bit QualNet can be compiled on Microsoft Windows XP Professional x64 Edition with one of the following compilers (see Table 2):

• VC8
• VC8 Express

To compile the 64-bit QualNet from the command line, perform the following steps:

1. Open a command window using one of the steps listed below.
   • For VC8, use the following command:

       Start > All Programs > Microsoft Visual Studio 2005 > Visual Studio Tools > Visual Studio 2005 x64 Win64 Command Prompt

   • For VC8 Express, use the following command:

       Start > All Programs > Microsoft Platform SDK ... > Open Build Environment Window > Windows XP 64-bit Build Environment > Set Windows XP x64 Build Environment (Debug)

2. Go to QUALNET_HOME\main directory using the cd command to change directories.
3. Make a copy of the appropriate Makefile.
   • For VC8, use the following command:

       copy Makefile-windows-x64-vc8 Makefile

   • For VC8 Express, use the following command:

       copy Makefile-windows-x64-vc8e Makefile
4. Compile QualNet by using the following command (it takes several minutes for QualNet to compile):

    nmake

This creates the QualNet executable in the QUALNET_HOME/bin directory. In Windows, the executable is qualnet.exe.

To recompile QualNet, run `nmake` again. However, it is sometimes useful to delete all object files before recompiling. Use the following commands to remove all object (.obj) files and recompile:

    nmake clean
    nmake

1.5.2 Compiling from Visual Studio 2005 IDE

If either Microsoft Visual C++ 2005 Express Edition or Visual Studio 2005 is installed (see Section 1.3.2), then QualNet can be compiled from the IDE.

Configuring Platform SDK

If Microsoft Visual C++ 2005 Express Edition IDE is used, then Platform SDK must be configured before QualNet can be compiled. This configuration needs to be done only once. Perform the following steps to configure Platform SDK.


2. From the drop-down list under Show directories for, select Executable files. Click on the folder button and add the path C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Bin.
3. From the drop-down list under **Show directories for**, select **Include files**. Click on the folder button and add the path `C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Include`.

4. From the drop-down list under **Show directories for**, select **Library files**. Click on the folder button and add the path `C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Lib`.

**Configuring Microsoft Visual Studio 2005 IDE**

If Microsoft Visual Studio 2005 or Visual C++ 2005 Express Edition IDE is used, then the IDE must be configured before QualNet can be compiled. This configuration needs to be done only once. Perform the following steps to configure the IDE.

1. Create a file named **Makefile** in the **QUALNET_HOME** directory. This Makefile contains commands to redirect to a makefile in **QUALNET_HOME\main**. (The indentations in the following Makefiles are tabs, not spaces.)

   - If you are compiling the 32-bit QualNet, the new file **Makefile** should contain the following lines:

     ```make
     all:
       cd main
       nmake -f Makefile-windows-vc8
     rebuild: clean
       nmake -f Makefile-windows-vc8
     clean:
       cd main
       nmake -f Makefile-windows-vc8 clean
     ```
• If you are compiling on the 64-bit QualNet using Microsoft Visual Studio 2005 IDE, the new file **Makefile** should contain the following lines:

```make
all:
    cd main
    nmake -f Makefile-windows-x64-vc8

rebuild: clean
    nmake -f Makefile-windows-x64-vc8

clean:
    cd main
    nmake -f Makefile-windows-x64-vc8 clean
```

• If you are compiling on the 64-bit QualNet using Visual C++ 2005 Express Edition IDE, the new file **Makefile** should contain the following lines:

```make
all:
    cd main
    nmake -f Makefile-windows-x64-vc8e

rebuild: clean
    nmake -f Makefile-windows-x64-vc8e

clean:
    cd main
    nmake -f Makefile-windows-x64-vc8e clean
```
2. Select **File > New > Project From Existing Code.**

![Screenshot of New Project from Existing Code dialog box](image)

Set the prompted values as follows:

- **Project file location:** `C:\qualnet\4.5`
- **Project name:** `qualnet`
- **Folder:** `C:\qualnet\4.5`
- **How do you want to build the project?:** Use external build system
- **Build command line:** `nmake`
- **Rebuild command line:** `nmake rebuild`
- **Clean command line:** `nmake clean`
- **Output (for debugging):** `bin/qualnet.exe`
Press Finish.

Compiling from Microsoft Visual Studio 2005 IDE
Once Microsoft Visual Studio 2005 or Visual C++ 2005 Express Edition IDE has been configured, it can be used as follows:

- Select **Build > Build Solution** to build QualNet.
- Select **Build > Rebuild Solution** to clean the object files and rebuild QualNet.
- Select **Build > Clean Solution** to clean the object files.

1.5.3 Testing QualNet
To test the QualNet installation on Windows, after compiling, open a command window and use the following commands:

```
cd %QUALNET_HOME%\scenarios\default
qualnet default.config
```

**Note:** If errors are displayed stating "Invalid (inconsistent) license key" or "Invalid host", please see the FAQ at [http://www.scalable-networks.com/distributions/license/faq.php](http://www.scalable-networks.com/distributions/license/faq.php).

To test the QualNet GUI, start the GUI by double-clicking on the following icon on the desktop (if desktop shortcuts were enabled in the installation process, as described in Section 1.2):
You can also start the QualNet GUI by navigating to QUALNET_HOME/gui/netbeans/bin in an explorer window and double-clicking on the file runide.exe.

The following startup screen is displayed when the QualNet GUI starts:

![QualNet Startup Screen]

**Note:** Some firewall programs may prevent QualNet GUI from running. To use QualNet GUI, you may need to add it to the exception list of your firewall program. Check the documentation of your firewall program for details on adding a program to the exception list or contact your system administrator. If you are using Microsoft Windows firewall see the following link for more details:

http://support.microsoft.com/kb/875357
1.6 Installing and Activating Addons

Addons are separate components of QualNet which provide enhanced features and functionality. They are distributed separately, in most cases, and may contain additional source code, pre-compiled library files, and third party utilities.

QualNet addons fall into the following classes:

- Libraries: Protocol (model) libraries sold with QualNet
- Interfaces: External interfaces requiring third party software
- Custom addons: Special purpose addon modules and user-developed addons
- Contributed models: Models developed and provided by Scalable Network Technologies customers for distribution

This section provides instructions for installing and activating addons on Windows systems.

1.6.1 Installing Addons

To install a QualNet addon on Windows, perform the steps listed below.

Notes:

a. The following instructions are sufficient to install most addons. Some addons may require additional steps (typically, to install third-party software required by the addon). See the documentation for the addon for any additional steps that need to be performed to install the addon.

b. The section uses the Satellite Library addon as an example. The name of the file for the Satellite Library addon is qualnet-4.5-Satellite-installer.exe. Users should modify the filename in the following instructions to match the name of the addon they want to install.

c. If you purchased QualNet and the addon together, your license file should allow you to run scenarios with the additional addon functionality. If you purchased the addon separately (at a later date) and did not receive an updated license file with your purchase, please contact license@scalable-networks.com.

1. Download the installation package (e.g., qualnet-4.5-Satellite-installer.exe) from the QualNet download page or load it from the installation CD.
2. Double click on the file qualnet-4.5-Satellite-installer.exe.
3. The ReadMe information dialog box is displayed. Click Next.
4. If you have installed QualNet in the default folder, C:\qualnet\4.5 (step 6 of Section 1.2), then the addon's files are automatically placed in the appropriate subdirectories of the QualNet installation directory. If QualNet was installed in a different folder, you will be prompted for the installation location.
5. Once the installation is complete, you will have the option to launch the addon documentation file. Click Exit.

Note: Check this file for any additional installation instructions and requirements before continuing.
1.6.2 Activating Addons

To activate a QualNet addon on Windows, perform the steps listed below.

1. Open the file QUALNET_HOME/main/Makefile-addons-windows with a text editor.
2. Locate and uncomment the include statement for Makefile for the addon:
   For the Satellite Library, change the line
   
   ```
   #include ../libraries/satellite/Makefile-windows
   ```
   to
   
   ```
   include ../libraries/satellite/Makefile-windows
   ```
3. Recompile QualNet, as described in Section 1.5.

   **Note:** Delete all object (.obj) files before recompiling by using the `nmake clean` command.

1.7 Helpful Links

- Helpful information on installation is available in the **Installation & Startup** section of **QualNet Community Forums**, which are accessible from the following URL:
  

  QualNet Community Forums require a free registration for access.

- You can also get help with common installation and licensing issues at QualNet's FAQ page:
  
2 Installation Guide for Linux/Solaris/Mac OS X

This section covers the system requirements, installation process, compilation, running, and debugging QualNet on Linux, Solaris, and MAC OS X systems.

Notes:

a. In the rest of this guide, we will refer to the three systems (Linux, Solaris, and MAC OS X) by the term UNIX.

b. This installation guide does not cover the requirements and instructions for installing, compiling, and running the distributed version of QualNet. See QualNet 4.5 Distributed Reference Guide for the requirements and instructions for the distributed version of QualNet.

2.1 System Requirements

2.1.1 Linux

QualNet is officially supported on Fedora Core 4, Red Hat Enterprise Linux 4, and SUSE Linux versions 9.3 and 10.1 on AMD64 and x86 compatible systems. QualNet is also known to work on other distributions of Linux with glibc version 2.3 and gcc versions 3.2 and higher. The minimum platform requirements to run QualNet on a Linux system are listed in Table 3.

### TABLE 3. Minimum Requirements for Linux

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>x86 compatible (including Core Duo, Pentium, Xeon, and Athlon). Or AMD64 compatible (including Opteron, Athlon 64, Core 2 Duo, and Pentium/Xeon EM64T).</td>
</tr>
</tbody>
</table>
| Memory        | - 512 MB for simulations of networks with up to 100 nodes.  
|               | - 768 MB for simulations of networks with up to 250 nodes.  
|               | - 1 GB for simulations of networks with up to 1000 nodes. |
| Disk          | 500 MB free disk space.                           |
| Expat Library | The appropriate expat library for your distribution must be installed. |
| Java          | Sun Java™ 2 SDK, Standard Edition, version 1.4.2 or higher. |
| C++ Compiler  | gcc 3.2 or later.                                 |
| OpenGL        | OpenGL library libGL.so.1.2 or higher             |

The following is the recommended configuration to run QualNet Developer on Linux:

- One of the following processors:
  - 3.2 GHz Pentium 4
  - 2.4 GHz 32-bit AMD
  - Any AMD 64-bit
- Any Intel Core Duo (or newer)
  - 1 GB memory
  - 700 MB free disk space
  - Sun Java™ 2 SDK, Standard Edition, version 1.4.2
  - gcc 3.2 or later. See Section 2.3.2 for details.

In the addition to the above, the following are recommended when running QualNet 3D Visualizer on Linux:
  - Graphics card with 128 MB memory
  - Display with 1024 x 768 resolution

2.1.2 Solaris

The minimum platform requirements to run QualNet on a Solaris system are listed in Table 4.

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Sun SPARC II or higher.</td>
</tr>
<tr>
<td>Operating System</td>
<td>Solaris 8 or higher.</td>
</tr>
</tbody>
</table>
| Memory        | - 512 MB for simulations of networks with up to 100 nodes.  
                 | - 768 MB for simulations of networks with up to 250 nodes.  
                 | - 1 GB for simulations of networks with up to 1000 nodes. |
| Disk          | 500 MB free disk space.                           |
| Expat Library | The expat library must be installed.              |
| Java          | Sun Java™ 2 SDK, Standard Edition, version 1.4.2 or higher. |
| C++ Compiler  | gcc 3.3                                           |

The following is the recommended configuration to run QualNet Developer on Solaris:
  - 1.5 GHz CPU
  - 1 GB memory
  - 700 MB free disk space
  - Sun Java™ 2 SDK, Standard Edition, version 1.4.2
  - gcc 3.3

In the addition to the above, the following are recommended when running QualNet 3D Visualizer on Solaris:
  - Graphics card with 128 MB memory
  - Display with 1024 x 768 resolution
2.1.3 Mac OS X

The minimum platform requirements to run QualNet on a Mac OS X system are listed in Table 5.

**TABLE 5. Minimum Requirements for Mac OS X**

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Apple PowerPC G4 or G5, Intel Core Duo or Xeon.</td>
</tr>
<tr>
<td>Operating System</td>
<td>Mac OS X 10.4.</td>
</tr>
</tbody>
</table>
| Memory          | - 512 MB for simulations of networks with up to 100 nodes.  
|                 | - 768 MB for simulations of networks with up to 250 nodes.  
|                 | - 1 GB for simulations of networks with up to 1000 nodes.  |
| Disk            | 500 MB free disk space.                            |
| Expat Library   | The expat library must be installed.                |
| Java            | Sun Java™ 2 SDK, Standard Edition, version 1.4.2 or higher.  |
| C++ Compiler    | gcc 4.0.                                          |

The following is the recommended configuration to run QualNet Developer on Mac OS X:

- 2.0 GHz Intel Core Duo CPU
- 1 GB memory
- 700 MB free disk space
- Sun Java™ 2 SDK, Standard Edition, version 1.4.2
- gcc 4.0

In the addition to the above, the following are recommended when running QualNet 3D Visualizer on Mac OS X:

- Graphics card with 128 MB memory
- Display with 1024 x 768 resolution

### 2.2 Installing QualNet

To install QualNet on a UNIX (Linux, Solaris, or Mac OS X) system, perform the steps listed below.

**Notes:**

a. QualNet is small enough that each user can install a separate copy of the software in their home directory. QualNet need not be installed in /usr/local or other shared directories.

b. The examples in this installation guide use the filename for the QualNet Commercial Release. Users may need to modify the filename in the following instructions to match the name of the file delivered.

c. For help with installation procedures or problems, contact support@scalable-networks.com.

1. Download the installation package (file qualnet-4.5-commercial.tar.gz) from the QualNet download page or load it from the installation CD.
2. Go to the home directory, and extract QualNet using the following command:

        gunzip -c qualnet-4.5-commercial.tar.gz | tar xvf -

UNIX users with GNU tar can also use the following command:

        tar xvfz qualnet-4.5-commercial.tar.gz

QualNet will be installed in ~/qualnet/4.5.

3. Copy the license file into the QualNet license directory.

   If a floating license server is not used, the license file name is of the form qualnet-<date>.lic, where
   <date> is the license expiration date. For example, the license file may be named qualnet-
   2008.06.30.lic. If a floating license server is used, the license file name is of the form client-<ip-
   address>.lic, where <ip-address> is the IP address of the client.

   Copy the license file into QUALNET_HOME\license_dir, where QUALNET_HOME is the directory
   where QualNet is installed.

   **Notes:**
   a. Be sure to check the file extension on your license file. It should end in ".lic". Depending on
      your system and method of copying, you may end up with an extra extension, such as qualnet-
      2007.12.31.lic.txt, which will not work.
   b. If this file cannot be located, inquire with the purchaser of QualNet. For users with the
      evaluation version of QualNet, the license file is sent as an email attachment from Scalable
      Network Technologies.
   c. If a license server is used, follow the instructions provided with the license files to install the
      server and client license files.

### 2.3 Installing Third-Party Software

QualNet requires the expat library, Java support, and a C++ compiler to run. This section describes how to install the required software on a UNIX system.

#### 2.3.1 Java Support

Sun Java 2 SDK, Standard Edition, version 1.4.2 or higher, is required to run the QualNet graphical tools. Go to the following URL for information on downloading Java:

2.3.2 C++ Compiler

To compile QualNet source code or custom addons, a C++ compiler is required. Install the version of gcc appropriate for your system as described below.

**Note:** To check the version of gcc installed on your system, type the following command in a command window: `gcc -v`.

- For Linux systems, the version of gcc depends on the glibc version of the Linux distribution. QualNet supports glibc 2.3.x through 2.4.x. To determine your version of glibc, run the following command:

  ```
  rpm -q glibc
  ```

See Table 6 to determine the gcc version required for your system.

### Table 6. C++ Compilers for UNIX Systems

<table>
<thead>
<tr>
<th>Operating System</th>
<th>gcc Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux glibc 2.3.x</td>
<td>gcc 3.2, gcc 3.4, gcc 4.0</td>
</tr>
<tr>
<td>Linux 64-bit glibc 2.3.x</td>
<td>gcc 3.3, gcc 4.0</td>
</tr>
<tr>
<td>Solaris</td>
<td>gcc 3.4</td>
</tr>
<tr>
<td>Mac OS X PowerPC</td>
<td>gcc 4.0</td>
</tr>
<tr>
<td>Mac OS X Intel</td>
<td>gcc 4.0</td>
</tr>
</tbody>
</table>

Install the right version of gcc from the Linux installation media or download site. Consult your system administrator for help with installing gcc.

**Note:** To enquire about QualNet support on operating systems or compilers not listed in Table 6, contact sales@scalable-networks.com.

- For Solaris SPARC systems, install gcc 3.4 from the SPARC CD-ROMs or go to the following URL for information on downloading gcc 3.4 for Solaris SPARC systems:


- For Mac OS X systems, download Xcode 2 from the download site or install it from the Mac OS X Installation DVD. Installing Xcode 2 also installs gcc 4.0 on the system.

2.3.3 Expat Library

- For Linux systems, install the expat library from the Linux installation media or download site. Consult your system administrator for help with installing the expat library.

- For Solaris SPARC systems, install the expat library from the SPARC CD-ROMs or go to the following URL for information on downloading the expat library for Solaris SPARC systems:


- For Mac OS X systems, the expat library is part of Xcode 2. It will be installed as part of the C++ compiler.
2.3.4 Open GL and Drivers
For Linux platforms, you also need to install the following software in order to run QualNet 3D Visualizer:

- OpenGL library libGL.so.1.2 or higher: Consult your system administrator for help with installing OpenGL.
- Graphics driver: Contact the manufacturer of the graphic card installed on your system for instructions to install the latest version of the graphics driver.

2.4 Setting Environment Variables
To set the QualNet environment variables on a UNIX system, perform the following steps:

1. Open a command window.
2. Edit the shell startup script. To check which shell you are using, type the following command in a command window: `echo $SHELL`.
   - For csh and tcsh
     Open ~/.cshrc and add the following lines:

     ```bash
     setenv QUALNET_HOME ~/qualnet/4.5
     set path = ( $path ~/qualnet/4.5/bin )
     ```
   - For bash
     Open ~/.bashrc and add the following lines:

     ```bash
     export QUALNET_HOME=~/qualnet/4.5
     PATH=$PATH:~/qualnet/4.5/bin
     ```
   - For sh
     Open ~/.profile and add the following lines:

     ```bash
     QUALNET_HOME=/home/username/qualnet/4.5; export QUALNET_HOME
     PATH=$PATH:/home/username/qualnet/4.5/bin
     ```

     **Note:** Replace `/home/username` with the absolute path to the home directory if necessary.

3. On some UNIX distributions (e.g., Fedora and Ubuntu), Java may be installed at a non-standard location. In that case, update the environment variable `JDK_HOME` to the directory where Java is installed.
   Assuming that Java is installed in the directory `~/myjavadir`, edit the shell startup script as follows:
   - For csh and tcsh
     Add the following line to `~/.cshrc`:

     ```bash
     setenv JDK_HOME ~/myjavadir
     ```
• For bash
  Add the following line to ~/.bashrc:

  ```bash
  export JDK_HOME=~/myjavadir
  ```

• For sh
  Add the following line to ~/.profile:

  ```bash
  JDK_HOME=/home/username/myjavadir; export JDK_HOME
  ```

To test that `JDK_HOME` has been set correctly, type the following command: `$JDK_HOME/bin/java`. This should display Java’s usage.

### 2.5 Compiling and Testing

#### 2.5.1 Compiling QualNet

To compile QualNet on a UNIX system, perform the following steps:

1. Open a command window.
2. Go to QUALNET_HOME\main directory using the `cd` command to change directories.
3. Make a copy of the original Makefile for the version of gcc installed on your system.

  **Note:** See Section 2.3.2 for the version of gcc required for your system. To check the version of gcc installed on your system, type the following command in a command window: `gcc -v`.

• For Linux (GNU gcc):
  - For 32-bit Linux machines running gcc versions 3.2, use the following command:
    ```bash
    cp Makefile-linux-glibc-2.3-gcc-3.2 Makefile
    ```
  - For 32-bit Linux machines running gcc versions 3.4, use the following command:
    ```bash
    cp Makefile-linux-glibc-2.3-gcc-3.4 Makefile
    ```
  - For 32-bit Linux machines running gcc version 4.0, use the following command:
    ```bash
    cp Makefile-linux-glibc-2.3-gcc-4.0 Makefile
    ```
  - For 64-bit Linux machines running gcc versions 3.3 and 3.4, use the following command:
    ```bash
    cp Makefile-linux-x86_64-glibc-2.3-gcc-3.3 Makefile
    ```
  - For 64-bit Linux machines running gcc version 4.0, use the following command:
    ```bash
    cp Makefile-linux-x86_64-glibc-2.3-gcc-4.0 Makefile
    ```
• For Solaris SPARC using gcc 3.3, use the following command:

    cp Makefile-solaris Makefile

• For Mac OS X using gcc 4.0 on PowerPC, use the following command:

    cp Makefile-darwin-ppc-gcc-4.0 Makefile

• For Mac OS X using gcc 4.0 on Intel, use the following command:

    cp Makefile-darwin-x86-gcc-4.0 Makefile

4. Compile QualNet by using the following command (it takes several minutes for QualNet to compile):

    make

This creates the QualNet executable in the QUALNET_HOME/bin directory. In UNIX, the executable is qualnet.

To recompile QualNet, run make again. However, it is sometimes useful to delete all object files before recompiling. Use the following commands to remove all object (.o) files and recompile:

    make clean
    make

2.5.2 Testing QualNet

To test the QualNet installation on UNIX, use the following commands after compiling:

    cd $QUALNET_HOME/bin/scenarios/default
    ./qualnet default.config

    Note: If errors are displayed stating "Invalid (inconsistent) license key" or "Invalid host", or if there is a segmentation fault (this occurs on default installations of Red Hat 9.3 and above), please see the FAQ at http://www.scalable-networks.com/distributions/license/faq.php.

To test the QualNet GUI, use the following commands to start the GUI:

    cd $QUALNET_HOME/gui/netbeans/bin
    ./runide.sh

The following startup screen is displayed when the QualNet GUI starts:
2.6 Installing and Activating Addons

Addons are separate components of QualNet which provide enhanced features and functionality. They are distributed separately, in most cases, and may contain additional source code, pre-compiled library files, and third party utilities.

QualNet addons fall into the following classes:

- Libraries: Protocol (model) libraries sold with QualNet
- Interfaces: External interfaces requiring third party software
- Custom addons: Special purpose addon modules and user-developed addons
- Contributed models: Models developed and provided by Scalable Network Technologies customers for distribution

This section provides instructions for installing and activating addons on UNIX systems.

2.6.1 Installing Addons

To install a QualNet addon on UNIX systems, perform the steps listed below.
Notes:

a. The following instructions are sufficient to install most addons. Some addons may require additional steps (typically, to install third-party software required by the addon). See the documentation for the addon for any additional steps that need to be performed to install the addon.

b. The section uses the Satellite Library addon as an example. The name of the file for the Satellite Library addon is qualnet-4.5-Satellite-tar.gz. Users should modify the filename in the following instructions to match the name of the addon they want to install.

c. If you purchased QualNet and the addon together, your license file should allow you to run scenarios with the additional addon functionality. If you purchased the addon separately (at a later date) and did not receive an updated license file with your purchase, please contact license@scalable-networks.com.

1. Download the installation package (file qualnet-4.5-Satellite-tar.gz) from the QualNet download page or load it from the installation CD.

2. Copy the compressed archive file qualnet-4.5-Satellite-tar.gz to the QualNet installation directory, ~/qualnet/4.5.

3. Extract the contents of the package using the following command:

   ```bash
gunzip -c qualnet-4.5-Satellite.tar.gz | tar xvf -
   ```

   UNIX users with GNU tar can also use the following command:

   ```bash
tar xvfz qualnet-4.5-Satellite.tar.gz
   ```

   The extracted files will be automatically placed in the appropriate subdirectories.

   **Note:** Check the addon documentation for any additional installation instructions and requirements before continuing.

2.6.2 Activating Addons

To activate a QualNet addon on UNIX, perform the steps listed below.

1. Open the file QUALNET_HOME/main/Makefile-addons-unix with a text editor.

2. Locate and uncomment the include statement for Makefile for the addon:

   For the Satellite Library, change the line

   ```make
   #include ../libraries/satellite/Makefile-unix
   ```

   to

   ```make
   include ../libraries/satellite/Makefile-unix
   ```

3. Recompile QualNet, as described in Section 2.5.

   **Note:** Delete all object (.o) files before recompiling by using the `make clean` command.
2.7 Helpful Links

- Helpful information on installation is available in the **Installation & Startup** section of [QualNet Community Forums](http://www.scalable-networks.com/forums), which are accessible from the following URL:


  QualNet Community Forums require a free registration for access.

- You can also get help with common installation and licensing issues at QualNet's FAQ page: